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Using	macros	in	excel	for	beginners

You	could	even	share	it	with	others.	Clearing	Data	in	a	Range	Clear	the	content	of	a	specific	range	of	cells,	useful	for	resetting	a	sheet.	Example:	A	macro	that	highlights	cells	with	values	greater	than	100	in	green	and	cells	with	values	less	than	100	in	red.	There	are	plenty	of	online	tutorials,	books,	and	forums	that	can	help	you	learn	how	to	write	and
implement	macros	in	Excel.	By	recording	simple	macros,	running	them	with	a	click,	or	even	writing	your	own	VBA	code,	you	can	save	time,	reduce	errors,	and	enhance	productivity.	This	will	help	you	avoid	errors	that	could	affect	your	data.	6	Click	OK.	Sub	ClearData()	Range("A2:B100").ClearContents	End	Sub	9.	The	file	must	be	saved	with
an	.XLSM	file	extension	to	denote	a	macro-enabled	file.If	you	opt	to	save	the	file	as	a	traditional	.XLSX	file,	any	macros	and	their	VBA	code	will	be	discarded.To	save	the	file	without	losing	your	macros,	perform	the	following	steps:In	the	Backstage	(click	File),	click	ExportClick	“Change	File	Type”Click	“Macro-Enabled	Workbook	(*.xlsm)”Click	“Save
As”Save	the	file	to	a	location	and	with	a	name	of	your	choosing.VBA	can	work	with	relative	references	in	Excel.	On	a	Mac,	click	Excel	in	the	upper-left	corner	of	the	screen	to	prompt	a	drop-down	menu.	Sub	ChangeFontStyle()	With	Range("A1:A10")	.Font.Name	=	"Calibri"	.Font.Size	=	12	.Font.Color	=	RGB(0,	0,	255)	'	Blue	color	End	With	End	Sub	5.
Macros	make	it	easy	to	automatic	tasks	in	Microsoft	Excel.	The	VBA	code	editor	opens.	Macros	in	Excel	have	a	wide	range	of	applications.	Click	and	drag	to	draw	a	button	on	your	worksheet.	Click	a	folder	in	which	you	want	to	save	the	Excel	file	(e.g.,	Desktop).	Example:	A	macro	that	calculates	and	displays	the	total	sales	for	a	given	month	from	a
dataset.	Macros	are	miniature	programs	which	allow	you	to	perform	complex	tasks,	such	as	calculating	formulas	or	creating	charts,	within	Excel.	To	start	recording	the	Unhide	macro:	1.	I	spent	12	years	in	corporate	roles	across	finance,	operations,	and	IT—managing	SAP	and	Oracle	projects.As	a	7-time	Microsoft	MVP,	I	have	deep	knowledge	of	tools
like	Excel	and	Power	BI.I	love	making	complex	tech	topics	easy	to	understand.	Then	select	Column	I	and	press	Ctrl	+	Shift	+	Right	Arrow	to	include	all	remaining	columns	on	the	right.	6.	Press	Ctrl	+	A	twice	to	select	all	cells.	We	will	use	“Create_A_Report”	as	our	macro	name.You	can	assign	a	shortcut	key	to	the	macro	for	easier	execution,	such
as	CTRL	+	R.You	can	store	the	macro	in	the	file	or	the	Personal	Macro	Workbook.You	can	add	a	description	to	the	macro	for	documentation	purposes.Click	OK	to	start	the	recorder.Every	click	and	everything	typed,	edited,	or	deleted	will	be	recorded.Notice	the	icon	in	the	lower-left	of	the	Excel	window	has	changed	from	a	“record”	button	to	a	“stop”
button.Let’s	perform	the	following	steps	to	creator	our	chart	that	will	be	reproduced	by	the	“Create_A_Report”	macro:Click	in	cell	A3	to	establish	the	upper-left	corner	of	the	data.	On	a	Mac,	the	shortcut	key	combination	will	end	up	being	⌥	Option+⌘	Command	and	your	key	(e.g.,	⌥	Option+⌘	Command+T).	This	makes	it	easier	to	identify	them
later,	especially	when	you	have	many	macros.	Click	OK	to	start	recording.	Excel	Macros	Examples	Excel	macros	can	automate	a	wide	range	of	tasks	to	improve	efficiency.	What	Are	Macros	in	Excel?	Right-click	anywhere	on	the	Column	Bar	then	click	Unhide.	A	"Save	As"	window	will	open.	Sub	FormatCells()	'	Apply	bold	font	to	cells	A1	to	A10
Range("A1:A10").Font.Bold	=	True	End	Sub	3.	Download	Article	Download	Article	This	wikiHow	teaches	you	how	to	enable,	create,	run,	and	save	macros	in	Microsoft	Excel.	In	the	Project	Explorer,	find	your	workbook	and	click	on	Modules.	8	Click	Save.	However,	the	Developer	tab	is	not	visible	in	the	Excel	ribbon	by	default.	He	is	technology
enthusiast	and	an	English	teacher.	This	can	be	anything	simple,	like	typing	names	into	a	sheet,	or	something	more	complex,	like	making	a	custom	chart.	Besides	recording,	you	can	also	create	macros	directly	using	VBA	code.This	article	will	mainly	talk	about	recording	macros	since	it’s	the	easiest	way.	1	Open	Excel.	The	recording	has	started.	Select
Customize	the	Ribbon.	Name	Macros	Clearly	When	naming	your	macros,	choose	descriptive	names	that	reflect	the	tasks	they	perform.	Write	VBA	Code:	Open	the	VBA	editor,	write	custom	VBA	code,	and	create	more	complex	macros	suited	to	your	needs.	If	you	do,	you	will	force	the	macro	to	always	select	the	defined	range.	This	box	is	near	the	bottom
of	the	"Main	Tabs"	list	of	options.	If	later	you	have	data	that	goes	beyond	that	range,	it	will	be	ignored.	3	Click	Save	As.	This	option	is	on	the	left	side	of	the	window	(Windows)	or	in	the	drop-down	menu	(Mac).	Best	Practices	for	Using	Macros	in	Excel	To	make	the	most	out	of	your	macros	and	ensure	they’re	safe	and	efficient,	here	are	a	few	best
practices:	1.	Now,	the	recorded	macro	is	ready	to	use.	How	to	create,	edit,	and	run	Excel	macros	to	automate	data	entry	and	tasks.	Below	are	some	common	use	cases	and	examples	where	macros	can	save	time	and	improve	workflow:	Formatting	Data:	Automatically	apply	specific	formatting	to	cells,	such	as	font	size,	color,	or	background	color.	Write
the	VBA	code	for	your	macro.	2	Click	File.	You	can	also	just	press	the	key	combination	you	set	for	the	macro.	How	to	Create	a	Macro	in	Excel	Without	Recording	If	you	want	to	create	a	macro	without	recording,	you’ll	need	to	write	VBA	code	manually.	There	are	many	tutorials	on	this.	This	opens	the	Macro	window.	Highlighting	Cells	Based	on
Condition	Automatically	highlight	cells	that	meet	certain	conditions	(e.g.,	values	above	a	specific	threshold).	If	you	do	so,	the	macro	will	run,	and	you	can	skip	the	rest	of	this	method.	Choose	where	to	store	the	macro	(typically	in	This	Workbook).	7	Wait	for	the	macro	to	finish	running.	Step	3:	Edit	the	Macro	(Optional)	Open	the	VBA	Editor	(press	Alt	+
F11).	This	will	make	it	easier	to	maintain	and	update	your	macros	later.	You	can	adapt	these	examples	to	suit	your	specific	needs	and	even	combine	them	for	more	advanced	automation.	Advertisement	1	Open	the	macro-enabled	spreadsheet.	Creating	macros	in	Excel	is	one	of	the	best	ways	to	automate	repetitive	tasks	and	enhance	your	productivity.
For	example,	if	you	frequently	format	your	data	the	same	way,	you	can	create	a	macro	to	automate	this	process.	In	this	guide,	we	will	walk	you	through	the	steps	of	how	to	use	macros	in	Excel,	from	recording	simple	macros	to	running	and	managing	them	effectively.	(Example:	MyFirstMacro)	Perform	the	actions	you	want	to	automate.	Then,	we’ll
touch	on	how	to	edit	macros	using	VBA	code,	with	some	tips	on	where	to	learn	more.Recording	a	macro	is	the	first	step	to	automating	tasks	in	Excel,	and	you	don’t	need	to	know	any	coding.	Advertisement	1	Understand	why	you	have	to	save	the	spreadsheet	with	macros	enabled.	You	can	use	this	keyboard	shortcut	to	run	the	macro	later.	On	a	Mac,
you	must	first	click	the	"Where"	drop-down	box.	Right-click	on	the	Excel	ribbon.	Learn	how	to	use	macros	in	Excel	to	automate	tasks	and	improve	productivity.	You	can	also	close	Excel	and	open	a	specific	Excel	file	by	double-clicking	it.	The	Developer	tab	gives	you	access	to	a	lot	of	useful	Microsoft	Excel	features	such	as	the	Visual	Basic	Editor.	Press
the	⇧	Shift	key	along	with	another	letter	key	(e.g.,	the	E	key)	to	create	the	keyboard	shortcut.	2	Click	the	Developer	tab.	Click	the	name	of	the	macro	which	you	want	to	run.	2	Click	File.	Running	Calculations:	Automate	complex	calculations	such	as	sums,	averages,	or	custom	formulas.	It	also	allows	you	to	quickly	insert	form	controls	such	as	buttons
and	checkboxes.	Saving	a	macro-enabled	spreadsheet	is	a	little	different	than	saving	a	spreadsheet	without	macros.	Advertisement	1	Enter	any	necessary	data.	If	you’d	like	to	see	an	example	of	such	a	scenario,	click	the	following	link	for	a	post	&	video	demonstration.Feel	free	to	Download	the	Workbook	HERE.	Doing	this	saves	your	macro	settings
and	begins	recording.	6	Click	Run.	Whether	you’re	working	with	large	datasets,	generating	reports,	or	performing	frequent	actions,	macros	can	save	you	time.	This	way,	we	can	inform	the	user	of	the	situation	and	not	attempt	chart	generation.	Save	time:	Automate	repetitive	tasks,	reducing	manual	work.	Doing	so	prompts	a	drop-down	menu.	On	the
right,	check	the	box	for	Developer.	I've	worked	as	an	economist	and	a	consultant.	Excel	macros	are	relatively	easy	to	learn,	especially	with	the	Macro	Recorder.	Now,	when	you	click	the	button,	the	assigned	macro	will	run.	Sub	HighlightCells()	Dim	cell	As	Range	For	Each	cell	In	Range("B2:B100")	If	cell.Value	>	500	Then	cell.Interior.Color	=
RGB(255,	0,	0)	'	Red	background	End	If	Next	cell	End	Sub	10.	If	it	does	not,	the	macro	will	result	in	an	error.We	can	build	in	a	bit	of	pre-testing	of	the	sheet	to	determine	if	the	sheet	is	empty	or	has	data.	Macros	can	save	significant	amounts	of	time	when	applied	to	repetitive	tasks,	and	thanks	to	Excel's	"Record	Macro"	feature,	you	don't	have	to	know
anything	about	programming	in	order	to	create	a	macro.	5	Create	a	shortcut	key	combination	if	you	like.	In	the	Assign	Macro	dialog	box	that	appears,	select	the	macro	you	want	to	assign	to	the	button.	Excel	VBA	is	easy	and	fun!	With	Excel	VBA	you	can	automate	tasks	in	Excel	by	…	We	want	this	to	be	dynamic	and	display	the	text	located	in	cell	A1	of
the	selected	sheet.This	change	needs	to	be	made	in	the	VBA	code	as	it	can’t	be	recorded	dynamically.To	open	the	VBA	Editor,	either	press	CTRL	+	F11	or	click	Developer	(tab)	->	Code	(group)	->	Visual	Basic.The	VBA	Editor	will	open	to	display	the	recorded	steps	as	code.	5	Check	the	"Developer"	box.	Jack	Lloyd	is	a	Technology	Writer	and	Editor	for
wikiHow.	Excel	will	remember	these	tasks	and	save	them	as	a	macro.Once	saved,	you	can	run	this	macro	whenever	you	need	to,	doing	the	tasks	again	automatically.	Step	4:	Run	the	Macro	Go	to	Developer	>	Macros	and	select	the	macro	you	want	to	run.	It's	in	the	upper-left	side	of	the	Excel	window.	It	allows	you	to	record	actions	in	Excel	and	convert
them	into	a	macro	without	needing	to	write	any	VBA	code.	In	the	"Name"	text	box,	type	in	the	name	for	your	Excel	spreadsheet.	in	the	drop-down	menu.	If	you're	an	Excel	VBA	beginner,	these	16	chapters	are	a	great	way	to	start.	Advertisement	Add	New	Question	Question	Can	I	use	a	macro	that	I	create	in	other	spreadsheets	and	future	spreadsheets
on	the	same	pc?	Step	4:	Edit	or	Modify	a	Macro	If	you	want	to	make	changes	to	an	existing	macro,	you	can	do	so	by	editing	the	VBA	code	in	the	VBA	Editor.	Excel	is	now	recording	your	actions	to	create	a	macro.	Then,	imagine	if	there	was	a	way	to	record	your	song	and	play	it	back	anytime	without	extra	work.	Any	step	you	perform	between	clicking
OK	and	clicking	Stop	Recording	while	be	added	to	the	macro.	Backup	Your	Data	Always	keep	backups	of	your	workbook,	especially	when	working	with	complex	macros	that	can	modify	large	amounts	of	data.	Notice	that	in	just	a	couple	of	clicks	or	the	press	of	a	keyboard	shortcut	we	have	a	perfect	chart	of	the	new	data.Well,	almost	perfect.The	chart’s
title	was	hard-coded	to	display	“Procurement	Dept”.	Notice	the	Hide_Columns	Sub	procedure.	Changing	Font	Style	Automatically	change	the	font	style	of	selected	cells	to	improve	readability.	When	done,	go	back	to	the	Developer	Tab	and	click	Stop	Recording.	In	this	step-by-step	guide,	we’ll	show	you	how	to	create	macros	in	Excel,	what	they’re	used
for,	and	provide	practical	examples	to	get	you	started.	For	example,	to	change	the	color	of	cells	in	range	A1:A10,	use	the	following	code:	Sub	FormatCells()	Range("A1:A10").Interior.Color	=	RGB(255,	255,	0)	End	Sub	Press	F5	to	run	the	macro,	or	assign	it	to	a	button.	On	a	Mac,	you'll	click	Preferences...	9	Perform	the	macro's	steps.	Click	Run.	Your
macro	will	be	stored	inside	your	spreadsheet,	making	it	possible	for	anyone	who	has	the	spreadsheet	to	access	the	macro.	By	creating	macros	in	Excel,	you	can	eliminate	repetitive	tasks,	save	time,	and	increase	efficiency.	This	will	be	a	more	elegant	and	professional	way	to	handle	the	situation.This	type	of	testing	cannot	be	created	via	the	macro
recorder;	it	must	be	written	manually.At	the	top	of	the	code,	enter	the	following	text:If	Range(“A3”).Value	“Position”	or	Range(“A4”).Value	=	“”	Then	Exit	Sub	ElseScroll	to	the	bottom	of	the	code	text	and	enter	the	following:End	IfIf	you	would	like	to	learn	more	about	the	VBA	language	and	improve	your	skills	at	creating	amazingly	flexible	macros,
check	out	my	VBA	course	using	the	link	below.To	test	the	macro	to	ensure	the	chart	title	is	dynamic	and	the	empty	sheet	detection	works,	select	a	different	sheet	of	data	and	run	the	macro.Notice	that	the	chart	title	mimics	the	text	located	in	cell	A1.If	we	select	an	empty	sheet	and	run	the	macro,	nothing	happens	because	the	sheet	contains	no
data.When	you	save	your	file	that	contains	any	macros,	you	cannot	save	the	file	with	a	traditional	.XLSX	file	extension.	VBA	(Visual	Basic	for	Applications)	is	the	programming	language	of	Excel.	As	you	grow	more	comfortable	with	macros,	learning	VBA	will	give	you	more	control	and	flexibility,	allowing	you	to	create	complex	automation	tasks.	5	Enter
a	name	for	your	Excel	file.	You	will	first	need	a	basic	understanding	of	VBA.	Conclusion	Creating	macros	in	Excel	is	a	powerful	way	to	automate	repetitive	tasks,	increase	efficiency,	and	streamline	your	workflow.	Double-click	the	Excel	app	icon,	which	resembles	a	white	"X"	on	a	green	box,	then	click	Blank	workbook.	A	macro	in	Excel	is	a	sequence	of
commands	that	you	can	record	or	write	in	VBA	(Visual	Basic	for	Applications)	to	automate	tasks.	Sub	CreateReport()	'	Summarizing	sales	data	Dim	totalSales	As	Double	totalSales	=	Application.WorksheetFunction.Sum(Range("B2:B100"))			'	Creating	a	report	summary	Sheets.Add.Name	=	"Report"	Range("A1").Value	=	"Total	Sales"	Range("B1").Value
=	totalSales			'	Create	a	chart	Charts.Add	ActiveChart.ChartType	=	xlColumnClustered	ActiveChart.SetSourceData	Source:=Range("A1:B1")	End	Sub	4.	2	Click	Enable	Content.	If	you	do,	the	chart’s	name	(ex:	“Chart2”)	will	be	hard-coded	into	the	macro	which	will	cause	a	failure	later	since	the	next	chart	will	be	a	different	name	like	“Chart3”.	It's	in
the	column	of	save	locations	near	the	left	side	of	the	window.	Step	2:	Record	a	Macro	The	Macro	Recorder	is	a	great	tool	for	beginners.	There’s	nothing	better	than	helping	someone	realize	they	can	do	it	themselves.	If	you	happen	to	make	a	mistake	during	the	recording	process,	you	can	always	delete	the	macro	and	try	again.	10	Click	Stop	Recording.
On	a	Mac,	you'll	click	Save	here	instead.	Click	OK.	This	option	is	in	the	drop-down	menu.	Sub	FormatRange()	With	Range("A1:E10")	.Font.Bold	=	True	.Interior.Color	=	RGB(255,	255,	0)	'	Yellow	background	.Borders.LineStyle	=	xlContinuous	End	With	Columns("A:E").AutoFit	End	Sub	2.	You	can	now	use	macros	in	Excel.	Doing	so	will	save	your	Excel
spreadsheet	to	your	selected	location,	and	your	macro	will	be	saved	along	with	it.	Click	Insert	Select	a	chart	shape.	How	to	Use	Macros	in	Excel:	Step-by-Step	Guide	Step	1:	Enable	the	Developer	Tab	To	use	macros,	you	need	to	access	the	Developer	Tab	in	Excel,	which	is	hidden	by	default.	Insert	a	new	module	by	going	to	Insert	>	Module.	Is	Excel
Macros	Easy	to	Learn?	Why	should	you	use	macros?	Modify	the	VBA	code	in	the	editor	to	suit	your	needs.	6	Click	the	"Store	macro	in"	drop-down	box.	Test	Macros	Before	Using	Them	Before	running	macros	on	important	data,	test	them	in	a	copy	of	your	workbook.	If	you	can	do	it	on	Excel,	a	macro	can	likely	automate	it	for	you.Here’s	how	to	use	a
macro:Record	it	by	doing	the	tasks	you	want	automated.	Step	3:	Running	the	Macro	Once	you’ve	created	or	recorded	a	macro,	you	can	run	it	to	perform	the	automated	actions.	Ask	a	Question	Advertisement	Thanks	Advertisement	Thanks	Advertisement	Written	by:	wikiHow	Technology	Writer	This	article	was	co-authored	by	wikiHow	staff	writer,	Jack
Lloyd.	Emailing	a	Report	(Using	Outlook)	Send	an	automated	email	with	a	report	attached	using	Outlook	from	Excel.	Select	View	Macros.	Efficiency:	Speed	up	processes	by	executing	multiple	steps	with	one	click.	You'll	find	this	on	the	left	side	of	the	Excel	window.	7	Click	This	Workbook.	Sorting	Data	Sort	data	in	ascending	or	descending	order	based
on	the	first	column.	If	you	opened	a	blank	workbook,	enter	any	data	which	you	want	to	use	before	proceeding.	Excel	automatically	generated	each	code	line	based	on	the	recorded	keystrokes	and	mouse	clicks.	Doing	so	will	prompt	a	drop-down	menu.	If	you	don't	save	your	spreadsheet	as	a	macro-enabled	spreadsheet	(XLSM	format),	the	macro	won't
be	saved	as	part	of	the	spreadsheet,	meaning	that	other	people	on	different	computers	won't	be	able	to	use	your	macro	if	you	send	the	workbook	to	them.	Whether	you’re	a	beginner	or	experienced	user,	mastering	macros	will	make	you	more	efficient	in	Excel.	Illustrated	7-step	process	you	can	use	to	quickly	create	a	basic	Excel	macro.	Excel	makes	it
really	easy	to	create	macros	by	just	doing	what	you	already	know.Think	of	it	this	way:	if	you	can	follow	a	series	of	steps	in	Excel	to	get	something	done,	you’re	just	a	few	more	steps	away	from	making	those	actions	automatic.If	you’ve	ever	recorded	a	video	on	your	phone,	you’ve	got	what	it	takes	to	make	macros.With	Excel’s	Macro	Recorder,	you	start
recording,	do	your	usual	tasks,	and	then	stop	the	recording.	This	will	help	you	identify	the	macro	later.	Press	Ctrl	+	S	to	save	your	changes.	In	the	"Macro	name"	text	box,	type	in	the	name	for	your	macro.	Here’s	how	to	use	it:	Enable	the	Developer	Tab	Record	a	Macro	and	Name	the	Macro	Perform	Action:	Required	Tasks	Stop	Recording	and	Run
when	required	2.	These	tasks	can	range	from	simple	formatting	changes	to	more	complex	operations	such	as	data	manipulation,	calculations,	or	generating	reports.	Double-click	the	module	that	contains	the	macro	you	want	to	edit.	5	Select	your	macro.	Using	the	Macro	Recorder:	The	Macro	Recorder	is	an	easy	tool	for	beginners	to	create	macros
without	needing	to	write	any	code.	Here’s	how:	Press	Alt	+	F11	to	open	the	VBA	Editor.	If	you	leave	the	chart	selected,	the	macro	code	will	refer	to	it	as	the	“active	chart”	without	any	specific	name.Perform	any	cosmetic	changes	to	the	chart	you	like,	such	as	changing	bar	colors,	add	data	labels,	customize	the	legend,	customize	the	title,	etc.Click	the
“Stop”	button	(bottom-left)	to	stop	the	recorder.To	test	the	macro,	select	a	sheet	of	new	data	and	launch	the	macro	recording	from	above.Macros	can	be	launched	in	many	different	ways:Pressing	the	keyboard	shortcut	assigned	to	the	macro	during	the	recording	process	(ex:	CTRL	+	R).Selecting	View	(tab)	->	Macros	->	View	Macros	->	select	the
macro	->	Run.Selecting	Developer	(tab)	->	Code	(group)	->	Macros	->	select	the	macro	->	Run.You	can	even	assign	macros	to	shapes	and	images	that	when	clicked	will	execute	the	macro.	Select	Columns	A	&	B	and	then	right-click	on	the	highlighted	Column	Bar	to	Hide	them.	Double-click	the	spreadsheet	that	has	the	macro	in	it	to	open	the
spreadsheet	in	Excel.	You	can	also	click	on	Edit	to	view	the	VBA	code	window.	Saved	macros	will	be	listed	here	and	you	can	Run	whichever	one	you	need.	4	Double-click	This	PC.	You	can	play	this	recording	back	anytime,	doing	the	work	for	you.	Singing	the	same	songs	repeatedly	would	get	exhausting.	Any	unwanted	steps	performed	during	the
recording	process	will	become	part	of	the	playback	procedure.	Great	work!		Now	you	have	two	recorded	macros	that	can	be	executed.	The	following	dialog	box	appears.Each	macro	requires	a	name.	You	can	run	it	with	the	assigned	shortcut	key	or	by	accessing	it	from	the	Macros	dialog.	If	you	don't	see	this	option,	skip	this	step.	For	example:	Sub
SimpleMacro()	MsgBox	"Hello,	Excel!"	End	Sub	Press	F5	to	run	the	macro.	From	simple	formatting	to	creating	complex	reports,	macros	are	a	powerful	tool	to	enhance	your	productivity	in	Excel.	Published	on:	April	2,	2021	Last	modified:	June	12,	2024I’ve	spent	over	20	years	helping	businesses	use	data	to	improve	their	results.	This	will	unlock	the
spreadsheet	and	allow	you	to	use	the	macro.	5.	Here’s	how	to	do	both:	1.	Data	Cleaning:	Remove	duplicates,	standardize	date	formats,	or	trim	unwanted	spaces	in	data.	How	to	Create	Macros	in	Excel	Step-by-Step	Follow	these	simple	steps	to	create	macros	in	Excel:	Step	1:	Enable	the	Developer	Tab	Go	to	File	>	Options	>	Customize	Ribbon,	and
check	the	Developer	box.	Conclusion	Using	macros	in	Excel	is	a	powerful	way	to	automate	repetitive	tasks	and	streamline	your	workflow.	Click	OK	to	enable	the	Developer	Tab.	4.	Yes,	you	can	use	a	macro	that	you	crate	in	other	spreadsheets	and	future	spreadsheets	on	the	same	pc.	Sub	SortData()	Range("A1:B100").Sort	Key1:=Range("A1"),
Order1:=xlAscending,	Header:=xlYes	End	Sub	8.	Click	the	chart	that	you	want	to	use.	It's	in	the	middle	of	the	window.	Sub	AutoPopulateCells()	Dim	i	As	Integer	For	i	=	1	To	10	Cells(i,	1).Value	=	"Product	"	&	i	Cells(i,	2).Value	=	i	*	100	'	Price	calculation	Next	i	End	Sub	6.	Auto-Populating	Cells	Automatically	populate	a	range	of	cells	with	data	based
on	certain	criteria.	Optionally,	assign	a	shortcut	key	to	run	the	macro.	Here’s	how:	Go	to	the	Developer	Tab	and	click	Insert	under	the	Controls	group.	Whether	you	use	the	Macro	Recorder	or	write	custom	VBA	code,	macros	can	save	you	time	and	enhance	productivity.	What	Is	the	Use	of	Macros	in	Excel	with	Examples?	Name	the	macro,	set	a
shortcut	key,	and	choose	where	to	store	it.	NOTE:	Do	NOT	highlight	the	data	range.	Remember,	with	the	right	approach	and	some	practice,	you	can	automate	a	wide	variety	of	tasks	to	make	your	work	in	Excel	faster	and	more	efficient.	Sub	SendEmail()	Dim	OutlookApp	As	Object	Dim	OutlookMail	As	Object	Set	OutlookApp	=
CreateObject("Outlook.Application")	Set	OutlookMail	=	OutlookApp.CreateItem(0)			OutlookMail.Subject	=	"Monthly	Sales	Report"	OutlookMail.Body	=	"Please	find	attached	the	sales	report	for	this	month."	OutlookMail.Attachments.Add	"C:\Path\To\Your\File.xlsx"	OutlookMail.To	=	"recipient@example.com"			OutlookMail.Send	End	Sub	These	10
Excel	macros	examples	demonstrate	the	wide	range	of	tasks	that	can	be	automated	using	VBA.	Creating	Custom	Reports	Automate	the	process	of	generating	reports	by	combining	data,	applying	calculations,	and	formatting	the	final	report	with	charts.	Depending	on	how	large	your	macro	is,	this	can	take	several	seconds.	In	the	Excel	Options	window,
click	Customize	Ribbon	in	the	left-hand	menu.	For	instance,	a	macro	could	be	set	to	format	all	cells	in	A1:A10	with	bold	text	and	a	yellow	background	color:	Sub	FormatData()	Range("A1:A10").Font.Bold	=	True	Range("A1:A10").Interior.Color	=	RGB(255,	255,	0)	End	Sub	This	macro	will	apply	the	same	formatting	every	time	it’s	run,	ensuring
consistency	and	saving	time.	If	you	don’t	see	any	code	in	the	window,	you	will	need	to	double-click	one	of	the	entries	labeled	“ModuleX”	on	the	left	side	of	the	screen	in	the	Project	Explorer	window.Scrolling	down	through	the	code	we	see	a	line	of	code	towards	the	bottom	that	reads…Selection.Caption	=	“Procurement	Dept”We	need	to	change	this	to
read…Selection.Caption	=	Range(“A1”).ValueI	said	you	can	use	macros	without	ever	working	with	the	VBA	code,	but	it’s	a	good	idea	to	learn	a	little	bit	of	code	so	you	can	perform	basic	maintenance	and	changes	to	the	macro	without	having	to	recreate	the	entire	macro.As	it	stands,	our	macro	assumes	that	the	sheet	it	is	executed	against	has	data.	4
Enter	a	name	for	the	macro.	This	method	is	ideal	if	you	need	more	flexibility	than	the	macro	recorder	offers	and	want	to	customize	the	code	further.	Choose	the	Button	(Form	Control)	option.	Question	How	can	I	write	macros	that	will	change	a	spreadsheet	as	soon	as	I	create	it?	Example:	A	macro	that	creates	a	monthly	sales	report	by	compiling	data,
generating	charts,	and	formatting	the	report	automatically.	If	you	have	a	specific	file	which	you	want	to	open	in	Excel,	double-click	that	file	to	open	it	instead.	You	should	now	see	the	Developer	tab.	Select	Store	macro	in:	This	Workbook	then	click	the	OK	button.	Whether	you’re	working	with	large	datasets	or	just	need	to	repeat	the	same	formatting
actions	across	different	worksheets,	macros	can	help	you	save	valuable	time	and	effort.	This	approach	gives	you	more	flexibility,	as	you	can	customize	your	macros	to	handle	more	complex	tasks	than	what	the	recorder	can	capture.	3.	You'll	find	it	in	the	Developer	tab's	toolbar.	Click	the	"Save	as	type"	drop-down	box,	then	click	Excel	Macro-Enabled
Workbook	in	the	resulting	drop-down	menu.[2]	On	a	Mac,	you'll	replace	the	"xlsx"	at	the	end	of	the	file's	name	with	xlsm.	Creating	Reports:	Generate	custom	reports	with	the	click	of	a	button.	8	Click	OK.	How	Can	I	Create	My	Own	Macros?	4	Click	Macros.	In	the	VBA	Editor,	click	Insert	>	Module	to	create	a	new	module.	It's	in	the	Developer	toolbar.
A	pop-up	window	will	appear.	Your	worksheet	should	now	look	like	this:	To	end	the	macro	recording:	8.	The	Record	Macro	feature	is	powerful	enough	for	general	spreadsheet	automation	needs.	Your	macro	will	begin	running.	Summarizing	Data	Use	a	macro	to	calculate	totals,	averages,	or	other	metrics	across	large	datasets.	Macros	in	Excel	are
automated	actions	that	can	save	time	and	improve	efficiency.	This	ribbon	contains	the	various	tools	for	creating	and	editing	macros.To	activate	the	Developer	ribbon:Right-click	on	any	visible	tab	and	select	“Customize	the	Ribbon…”.In	the	Excel	Options	dialog	box,	place	a	check	next	to	the	“Developer”	entry	on	the	right	panel	of	options,	then
click	OK.You	now	have	access	to	all	the	cool	toys.Think	through	all	the	steps	you	are	going	to	perform	before	creating	the	recording.	This	will	save	your	macro.	In	the	Record	Macro	dialog	box:	Name	your	macro	(e.g.,	“FormatData”).	Sub	RemoveDuplicates()	Range("A1:A100").RemoveDuplicates	Columns:=1,	Header:=xlNo	End	Sub	7.	3	Click	the
Developer	tab.	You	don’t	have	to	write	or	edit	VBA	code	for	the	macro.	That’s	how	macros	work.Let’s	dive	into	an	example.Suppose	we	receive	a	daily	report	of	data	that	we	are	required	to	turn	into	a	specific	type	of	chart	with	various	features	and	customizations.The	catch	with	the	data	is	that	some	days	there	are	more	rows	of	data	than	other
days.We	want	to	make	the	process	of	chart	creation	completely	dynamic,	so	we	don’t	have	to	create	the	chart	from	scratch	every	time	we	receive	a	new	day’s	file.To	record	a	macro,	click	either	the	“Record	Macro”	button	located	in	the	lower-left	corner	of	the	Excel	window……	or	select	View	(tab)	->	Macros	->	Record	Macro.If	you	want	to	record
macros	the	way	the	“cool	kids”	do	it,	you	can	activate	a	special	ribbon	known	as	the	Developer	ribbon.	Be	Cautious	with	Macros	from	External	Sources	Macros	can	contain	harmful	code,	so	never	enable	macros	in	files	from	untrusted	sources.	The	Developer	Tab	will	now	appear	on	the	ribbon,	providing	you	with	tools	for	recording,	editing,	and
running	macros.	Perform	the	actions	you	want	the	macro	to	automate	(e.g.,	formatting	cells,	creating	charts,	etc.).	Co-authors:	20	Updated:	December	31,	2024	Views:	774,484	Categories:	Microsoft	Excel	Print	Send	fan	mail	to	authors	Thanks	to	all	authors	for	creating	a	page	that	has	been	read	774,484	times.	In	the	Macro	dialog	box,	select	the
macro	you	want	to	run.	It's	in	the	toolbar.	To	add	it:	1.	When	you	record	a	macro,	Excel	is	secretly	writing	your	actions	in	VBA	code.	Name	this	macro	Unhide_Columns.	It's	at	the	bottom	of	the	window.	This	article	has	been	viewed	774,484	times.	It's	at	the	top	of	the	Excel	window.	Click	on	the	Stop	Recording	macro	button	to	finish	up.	2.	3	Click
Record	Macro.	7	Select	a	save	location.	Here’s	how:	Go	to	the	Developer	Tab	and	click	Macros.	Always	inspect	the	code	if	possible	before	running	it.	Consistency:	Ensure	that	tasks	are	performed	the	same	way	each	time.	The	recorder	allows	beginners	to	create	simple	macros	without	writing	any	code.	Edit	the	macro’s	code	to	make	further
customizations.	You	can	even	set	a	shortcut	key	for	your	macro,	making	it	even	quicker	to	use.Macros	work	because	of	a	computer	language	called	Visual	Basic	for	Applications	(VBA).	He	has	over	two	years	of	experience	writing	and	editing	technology-related	articles.	Sub	SummarizeData()	Dim	total	As	Double	total	=
Application.WorksheetFunction.Sum(Range("B2:B100"))	MsgBox	"The	total	sum	is:	"	&	total	End	Sub	3.	Write	your	VBA	code.	Step	2:	Record	a	Macro	Click	Record	Macro	in	the	Developer	Tab.	Written	in	Visual	Basic	for	Applications	(VBA),	macros	allow	you	to	automate	actions	like	formatting	cells,	running	calculations,	and	even	interacting	with
other	applications	like	Word	or	PowerPoint.	To	create	macros	yourself,	you'll	need	to	enable	macros	in	the	Developer	menu	of	Excel.	Here	are	10	common	examples	of	what	you	can	automate	with	Excel	macros,	along	with	the	corresponding	VBA	code	to	help	you	get	started:	1.	Using	the	Developer	tab	Let’s	record	another	macro	to	Unhide	the	hidden
columns.	The	name	cannot	contain	any	spaces	and	must	be	unique	to	this	file.	What	Are	Macros	in	Excel	with	an	Example?	This	could	include	sorting	data,	applying	filters,	and	summarizing	information.	Here’s	how	to	enable	it:	Click	on	File	in	the	ribbon,	then	choose	Options.	7.	On	the	right	side,	check	the	Developer	tab	checkbox.	Macros	in	Excel	are
one	of	the	most	powerful	tools	available	to	automate	repetitive	tasks,	streamline	workflows,	and	boost	productivity.	It's	in	the	upper-left	corner	of	the	Excel	window	(Windows)	or	the	screen	(Mac).	Here’s	how	to	do	it:	Go	to	the	Developer	Tab	and	click	Record	Macro.	It's	in	a	yellow	bar	at	the	top	of	the	Excel	window.	By	following	the	steps	outlined	in
this	guide,	you’ll	be	well	on	your	way	to	mastering	Excel	macros.	It's	on	the	right	side	of	the	window.	Formatting	a	Range	Automatically	apply	consistent	formatting,	such	as	adding	borders,	changing	font	styles,	or	setting	column	widths.	Alternatively,	if	you	assigned	a	shortcut	key	when	creating	the	macro,	you	can	simply	press	the	shortcut	to	execute
the	macro.	Use	Comments	in	VBA	Code	If	you	write	your	own	VBA	code,	use	comments	to	explain	what	each	part	of	the	code	does.	Doing	so	opens	a	toolbar	here.	There	are	two	ways	to	create	your	own	macros	in	Excel:	Record	Actions:	Use	the	Macro	Recorder	to	automatically	generate	VBA	code	for	the	actions	you	perform.	But	if	you	want	to
customize	your	own	VBA	macro,	you	can	learn	more	about	Visual	Basic	for	Applications	(VBA)	here.	An	Excel	macro	is	like	a	recording	of	tasks	you	do	in	Excel.	Step	5:	Assign	Macros	to	Buttons	To	make	it	even	easier	to	run	your	macros,	you	can	assign	them	to	buttons	on	the	worksheet.	After	that,	you	can	make	Excel	repeat	those	steps	for	you
anytime,	super	fast.Imagine	you’re	a	singer	who	can	only	perform	live.	Right-click	on	the	highlighted	Column	Bar	then	click	on	Hide.	Click	Stop	Recording	when	done.	A	pop-up	window	will	open.	4	Click	Customize	Ribbon.	This	opens	the	Customize	Ribbon	window.	How	Do	I	Create	a	Macro	in	Excel:	Methods	Creating	macros	in	Excel	can	be	done	in
two	ways:	recording	actions	or	writing	custom	VBA	code.	If	later	you	have	less	data,	you	will	end	up	selecting	too	many	cells	and	have	empty	areas	in	your	report.To	properly	select	the	data	range	so	it	will	be	dynamic	during	future	executions,	press	CTRL-Shift-Down	arrow	then	press	CTRL-Shift-Right	Arrow.To	create	the	chart,	select	Insert	(tab)	->
Charts	(group)	->	Combo	Chart.A	new	combo	chart	has	been	inserted	into	the	file.Do	NOT	click	away	from	the	chart	and	reselect	it.	Start	experimenting	with	Excel	macros	today	and	see	how	automation	can	improve	your	tasks	and	workflow!	Creating	macros	in	Excel	is	a	powerful	way	to	automate	repetitive	tasks,	increase	efficiency,	and	streamline
your	workflow.	To	view	all	of	the	available	Excel	macros	:	1.	Click	on	the	Record	Macro	button	in	the	Developer	tab.	This	option	is	at	the	top	of	the	Excel	window.	Easy	step-by-step	explanation	and	practical	example	for	macro	beginners.	Using	one	of	the	methods	described	above,	start	the	macro	recorder.	Good	job!		You	have	created	your	first	macro
in	Excel!	But	wait,	where	is	the	recorded	macro?	On	the	View	ribbon,	click	on	Macros	and	select	Stop	Recording.	I’m	always	learning	new	things	too	and	finding	better	ways	to	help	others	succeed.	Advertisement	3	Click	Options.	Example:	Formatting	Data:	You	can	create	a	macro	to	automatically	format	a	range	of	cells.	6	Change	the	file	format	to
XLSM.	For	example,	if	you	wanted	to	create	a	macro	which	turns	two	columns'	worth	of	data	into	a	chart,	you	would	do	the	following:	Click	and	drag	your	mouse	across	the	data	to	select	it.	Example:	A	macro	that	removes	extra	spaces	from	text	data	and	formats	it	into	a	clean	list.	Writing	VBA	Code:	For	more	flexibility	and	control,	you	can	write
custom	VBA	code	for	your	macros.	Macros	in	Excel	are	small	programs	or	scripts	that	automate	a	series	of	tasks	within	Excel.	Removing	Duplicates	Automatically	remove	duplicate	values	in	a	selected	column.	This	time,	you	can	record	the	macro	from	the	Developer	tab.	It's	on	the	left	side	of	the	Excel	Options	window.[1]	On	a	Mac,	click	instead
Ribbon	&	Toolbar	in	the	Preferences	window.	Follow	this	step-by-step	guide	to	record,	run,	and	manage	your	Excel	macros.
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